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FOREWORDS

Congratulations on your purchasing the Digital Level DL-201/2007. In order to operate
this instrument correctly, please read this user manual carefully and keep it well so as
to refer o it easily in the future. Before use, please check the standard features and

make sure all the equipments and accessories are available.

In order to facilitate reading, some pictures are simplified.



PRECAUTIONS

Before using this instrument, please make sure that each function is running well.
eAvoid to make the surface of the digital staff as well as the joints between each
section dirty or damaged, otherwise it will influence on the accuracy of reading and
measurement. This is because the instrument needs to transfer the black & white bar
code to electric signal. That's why in case the digital staff is dirty, the accuracy would
be descended, or even the instrument is not able to measure.

eTripod

The digital level should be mounted on wooden tripod. Metal tripod is lighter and
shack easily, which will affect the accuracy. Each leg of the fripod should be fixed
well by screws.

eTribrach

Please check the adjusting screw on the fribrach frequently, do make sure the central
fixing screw is tightened.

ePacking well to avoid the instrument shaked

The digital level should be handled carefully to avoid shaking and crashing during
fransportation. Severe shaking would damage the measurement functions. When
packing the instrument in the case, make sure the instrument is power off and take
off the battery foo.

oCarry the instrument carefully

When you need to move the instrument, you must grasp the lifing handle and take it
off from the tripod.

eAvoid to expose the instrument in sun, rain or humid condition

Leaving the instrument in place of high temperature (+50 °C ) would damage the
instrument. Do not shoot the sun with the objective len; otherwise the spare parts
inside the instrument may be damaged.

eAvoid the great change of temperature

A great change on instrument femperature would descend the measuring range.
For example, when the instrument is moved out from a hot car, please leave the
instrument fo adapt to the surrounding temperature before use.

eBattery Inspection

Check the remaining battery before use.

eDigital Stoff



Wear a glove when using a digital staff.

SAFETY GUIDE

Serious injury or even death may occur if the following cautions are ignored.

e|n case of explosion, do not place the instrument close to inflammable gas, liquid,
or solid. Do not operate it in coal mine or dusty place.

Do not disassemble or repair the instrument without authorization in case of dangers
like fire, electric shock or damage to the instrument. Disassembling and
maintenance are only implemented by RUIDE and its authorized service providers.
eDo not use the telescope fo sight af the sun or sunlight that are refracted by
reflectors like prisms in case of any hurt fo the eyes.

eDo not operate the instrument with the digital staff near high voltage cables or
fransformers, in case of electric shock accident.

eDo not use the digital staff when under bad weather (thunder) in case of electric
shock.

Do not use chargers and batteries produced by a third party in case of fire.

Do not use a broken power supply, wires, sockets and plugs in case of fire or electric
shock.

Do not use humid batteries or chargers in case of fire or electric shock.

eDO not place the batteries in fire or high-femperature environment in case of
explosion or damage.

eDo not use the power supply mentioned in the manuals of non-manufacturers in
case of fire or electric shock.

eDo not circuit the batteries in case of fire.

Do not disassemble or assemble the instrument or operate the plug with wet hands
in case of electric shock.

Do not cover the charger when it is charging in case of fire.

eDo not touch the liquid leaked from the battery in case of hurt by the harmful
chemicals. And please change the battery.

e|njury to persons or damage to goods may occur if the following cautions are not
followed by operators.

eHarm: means hurt, bum, electric shock, etc.



eDamMage: means serious damage caused 1o building, instrument or furniture.
eQOverturning the instrument case may damage the instrument.

eDo not stand or sit on the case.

Do not use the instrument case with broken belt, buckle, hinge, or lifing handle, in
case that the instrument is damaged or it hurts the legs if the case falls.

eWhen mounting or delivering the instrument please be careful with the leg tips of
the fripod.

e\When mounting the instrument on the tripod, make sure the central fixing screw is
fightened well to prevent the instrument from falling down.

e\When mounting the instrument, make sure the screws of the fripod are tightened
well,

e\When moving the tripod, make sure the screws of the fripod are tightened well.

OPERATOR

oThis instrument is only operated by technician.

It is required that the operator should be a qualified surveyor. Before operation,
inspection and calibration, operators should be acknowledged the safety guidence.
ePlease wear necessary suits for protection (e.g. safety shoes, safety helmet).

Do not place the instrument directly on the ground. If the operator has o leave the
instrument alone, please cover the instrument with a nylon cover (if available).
DECLARATION OF EXCEPTIONAL RESPONSIBILITY

eUsers of this product should read the user manual thoroughly and implement
periodical inspection 1o the performance of the instrument.

eManufacturer and its dealers shall not be responsible for any direct or indirect
consequences and profit loss resulted from destructive or intentional improper use.
eManufacturer and its dealers shall not be responsible for any direct or indirect
consequences and profit loss resulted from natural calomities (e.g. earthquake,
huricane, flood, etc.), fire, accidents, or fault of a third party.

eManufacturer and its dealers shall not be responsible for failure to operate resulted
from the fact that the data is changed or lost, or that operation is inferfered.
eManufacturer and its dedlers shall not be responsible for any consequences and

profit loss resulted from exira use without following the user manual.



eManufacturer and its dedlers shall not be responsible for any consequences and
profit loss resulted from improper fransportation or connecting with other products.



1. NAME OF EACH COMPONENT & ITS FUNCTION

1.1 Name of Each Component
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1

2
3
4
5
6
7

battery

rough collimator

LCD display

keyboard panel

keys

eyepieces: use for adjusting the definition of the crosshair.

protecting cover of eyepieces: by releasing this cover, you can implement the

mechanical adjustment of the reticle in order to correct the optical colimation line

elror.

8

9

10
11
12
13
14
15
16
17
18

data fransfer port: connecting with PDA or computer.

reflector of circular vial

circular vial

fribrach

liffing handle

model label

objective lens

focusing hand wheel: use for focusing of digital staff,
power/measure key: use for instrument power ON/OFF, and measure.
horizontal tangent hand wheel

horizontal dial: use for setting the horizontal direction value of the collimating

direction to O or other required values.

19

leveling screws of the tribrach



1.2 Operation Keys & Functions

key name function
Power Power ON/OFF, and start to measure.

POW/MEAS ON/OFF Power ON: press once;

Measure Power OFF: hold on for 2 seconds.

MENU menu Returmn to the menu list.

DIST distance In measurement status, press it to start measure
measure the distance and display the distance.

T select Tum the page of menu list or data list.

— Number Tum the left or right page when viewing the data,

— moving or move left or right in inputting status.

ENT enter To confirm the parameters or inputting data.

ESC ESC To escape from menu or any setting mode. Also
0 go backspace fo delete a character in
inputting mode.

0~9 number keys | Inputting numbers.

— Mode of | Use for inputting inverse staff. Set the inverse staff.
setting You should activate this function in parameter
inverse staff setting first.

2= ilumination | Tum ON/OFF the illumination
decimal Input a decimal point; while inputting symbols or
point characters use this key fo switch between

alphabets and numerals.

REC Record key To record the measured data
Enter the sefting mode 1o set the measurement

SET Set key parameter, condition parameter and instrument
parameter,

SRCH Search key Use for searching and displaying the record
data.

Infermediate | To measure the infermediate point or to skake

IN/ SO point/Stake out while canying out the Leveling
out key measurement.
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MANU Manually To input the data manually when the [MEAS] key
input key cannot be used to take measurement.
Repeat To repeat measuring the measured backsight or
REP measurng foresight point in the leveling measurement
key
1.3 Display

The display adopts dot matrix LCD,

LCD illumination:

ON/OFF,

displaying 4 lines, with 20 characters in each.

Press ¥® to tum ON or OFF the illumination. It can be set in instrument parameters

foo.
Setting Contrast
There're 9 degrees for the contrast. Please refer to parameter setting to know how to
set the contrast.
Example:
Menu 1/2 Menu 172 Measure
» Standard Mode Standard Mode Rod:
Leveling » Leveling Dist:
Adjust Adjust N:3 S>>>>>>
Stardard Mode Leveling Mode Measuring

1.4 Symbols

11



key function key function

Several pages or menus are

The current data has b available which can be selected
o} a
been saved. by [A][V],
b: fotal pages, a: curent page
. | Battery level Inst Ht Instrument height
BM# Bench Mark CP# Changeover Point

| Staff Inversion
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2. PREPARATION FOR MEASUREMENT
2.1 Mounting the Instrument
Placing the Tripod.

Type E aluminum tripod with flat or dome head tripod is required.

(1) Adjust the three legs of the tripod o a proper length and tighten the fixing screws
at the middle of the leg.

(2) Tighten the hexagonal nut on the head of the tripod in order to make the tfripod
legs not too loosen. Place the tripod on a certain point, expand the legs until the
distance between each leg is about Tm. First, fix a leg, and move the other 2 legs to
make the head of the fripod approximately leveled. If necessary, adjust the length of
the tripod legs.

(3) ample the legs into the earth or fix it well on the ground.

Mount the Instrument on the Head of the Tripod.

Take out the instrument carefully and place it on the head of the tripod.

(1) Aim the tripod central screw fo the center of the fribrach and fighten the screw
until it is fixed af the head of the tripod.

(2) If you need to define an angle or a line through the horizontal dial, you should
center the instrument precisely with a plummet.

(3) Center the circular bubble by adjusting the three leveling screws of the fribrach. If
you are using a dome headed tripod, you should slightly loosen the tripod central
screw and rotate the instrument round the head of the tripod until the circular bubble
is centered, then fighten the screw.

Mounting the Instrument on a Certain Point (centering)

If you need to measure an angle or alignment, please precisely center the
instrument at a certain point with the plummet.

(1) Hang the plummet atf the plummet hook of the central screw of the fripod.

(2) Adjust the plummet line to a proper height.

(3) In case the instrument is not centered at the known point, you can move the
instrument fo that point without changing the position relationship between the fripod
leg and its head. First, put the tripod on the known point approximately until the
plummet is about Tcm away from the point. Second, grasp two legs of the tripod
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and adjust the tripod by the third leg until the head of tripod is leveled approximately
with a proper height. Expand the legs of the tripod and fix it on the ground.

(4) Finally, observe the plummet and the hook and trample the legs into the ground.
(8) Slightly loosen the central screw of the fripod and move the instrument on the
head until the plummet is centered at the known point. Tighten the tfripod central
SCrew.

Leveling the Instrument

Center the circular bubble by adjusting the tribrach screw.

First, put the tribrach as the below picture shown. Rotate 2 screws at the same time in
opposite direction until the bubble Mmoves to a position where the line between the
bubble and screw C is perpendicular to the line between screw A and B (refer to
Picture A). Then rotate the screw C to move the bubble o the center of the central
circle. This procedure should be repeated for times until the bubble is centered on
any directions. While leveling, remember the “Left Thumib Principle” which means that
the moving direction of the bubble is the same as that of the left thumb. Do not
rotate the leveling screw without thinking.

_

=

h O\
0}

Notice: Do not touch the telescope during leveling.

Cn

©

Collimating and Focusin

(1) Sight ot the digital staff with the rough caollimator.

(2) Rotate the eyepiece slowly until the image of the crosshair becomes clear.

(3) Rotate the focusing hand wheel until the image of digital staff becomes clear.
Rotate the horizontal fangent to move the image of the staff fo the center of the
vertical hair of the crosshair.

14



(4) Observe through the eyepiece. Move your eye slightly up, down, left and right to
check whether the relative position between the crosshair and the image of the staff
is not changed. If not, please return to step 1.

Notice: Measurement accuracy may be influenced if the crosshair and focusing is

not clear.

2.2 Power On
Press the power key (POW/MEAS).

2.3 Remaining Battery Display
The battery symbol indicates the remaining battery.

battery symbol
Menu ﬁ
» Standard Mode
Leveling
Adijust
Full
Sufficient
Half

Battery low. Please change the battery.

o B P B

The power will be cut off soon. You need to change the battery.

15



2.4 Setting the record mode
In order 10 save the measurement data in the intemal memory of the instrument, the
data saving mode should be set as auto save before leveling measurement. The
default setting is “"OFF”.

Flash:

Save the measured data (jobs) into the intemal memory

eUser can choose "Flash” in *Out Module” of “Condition” Setting if the data needs to
be saved in the flash.

The memoiry is 16 Mbit

*The maximum storage of memory is about 20,000.

*The maximum number of jobs is 256.

*Folder can not be created in the memory.

SD Card:

The measured data can be saved directly into the SD card.

* User can choose "SD” in *Out Module” of “*Condition” Setting if the data needs to be
saved in the SD card.

Communication Port:
Connect the instrument with external device by cable to receive the real-time
measuring data.

User can only use Standard Measurement mode in this condition.
Off:
The measuring data will be displayed without storing and outputting, user can not use

Leveling Measurement mode in this condition.

See next page for the example.

16



Operating Procedures Operation Display
1. Press [Setf] key to enter the Menu 1/2
setting mode on Menu screen, [SET] » Standard Mode
see detail in Chapter 9 “Set”. Leveling
Adijust
2. Press [A] or [¥] key to ente Setting
the “Out Module” in Condition [A]or[V] Measurement
setting. » Condition
Instrument
3.Press [ENT] key; Condition 1/2
[ENT] Point No.
Wait Time
» Out Module
4. Press [A] or [ V] key fo select. Out Module 12
[A]or[V] > OFF
Flash
SD
Out Module 1/2
5. Press [ENT] to confirm. [ENT] OFF
» Flash
SD

Note When the outfput is in “Flash”, the “F* mark will be displayed on the top right side of
the screen; when the output is in SD card, the “S” mark will be displayed; when the output
is by USB, the “U” mark will be displayed; when the output is off, no mark will be displayed.
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2.5SD Card
User can use SD card for data storage, data copy and data search.

SD card function only can be used while the “Out Module” is set as “SD”

To format the SD card please refer to the Chapter 7 “Format Flash or SD Card”

For SD card management, please refer to the Chapter 8 “Data Manage”

Note: When the system is loading data from the SD card, do not remove the battery
and SD card, otherwise, the saved data will be damaged, even it will influence on

the memory storage; the defective SD card may damage the memory storage.

2.6 Menu
The menu includes following programs, the funcfions located in different menus which
can't be aways optional at the same time. (You may change the mode for different
functions)
For example, when the "Out Module” is "“Communication port” or “OFF”, the Leveling Mode
and Adjust Mode can not be carried out. If user entersthe Leveling mode, the “Start Levelng”

and "Confinue Levelng” can not be chosen at the same time.

1% Menu 2™ Menu 3“ Menu ‘ 4™ Menu
Measure
Standard 5.0 G.H
Mode SOHD
S.0 Dist
Start Leveling BFFB
Leveling Continue BBFF
End Leveling BF/BIF
Outwargd/Return
. Method A
Adjust
Menu Method B
Make Group
Input Pt
Data Search Flash / SD Job / PN/ BM#
manage Copy Job Flash / SD
Delete Job Flash / SD
Check Capacity Flash / SD
File Out Flash / SD
Format Flash / SD

18




2.7 SET
"Set” key is used for setting the parameters.When carry out the precise measurement, it is
recommended fo use the continuous measuring mode which will help improve the
accuracy by the average value; "Auto power off” is available, which means that the power
will be cut off in 5 minutes without any operation; Data will be saved automaticaly in the

Leveing mode whike power off; The backight can be switched by using the 9% key.

Measure Mode Single / N Times / Continuous
Minimum Reading Standard 1mm / Precise 0.1mm
Inverse Mode Use / No Use
Measurement Unit m(meter) / fi(US.ft)
B-F sight distance Dif/Cumulated
sight distance Dif /limited HD
Limited folerance
Diflimited Dif of HD Dif/limited
SET sight distance/limited sight height
Point No. Increase / Descend
Wait Time 1~9 Second
Condition Out Module OFF/Flash/SD/Communication port
Communication Standard / User
Auto Off 5 min / Off
Contrast 1~9
Instrument Backlight On/Off
Instrument Info

2.8 Inputting Characters
When the "Out Module” is on, user can input the alphabets and numerals in the place
that needs to be noted.

Program Character Maximum
Group Only capital letter, number and ™" etc. | 8 Characters
(SD Card Only)

Info Lowercase and capital letter, numiber | 16 Characters
and all symbols
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For example: Input *Tp#7" in Info1

Operating Procedures Operation Display

Measure

1. Press [o] key fo enter the (o] Info#1

capital lefter inputting mode. =>

2. Press [«] or [P] key until the [lor™] Measure

cursor floshes in  the let Info#1 ?

er'T. =>
QRSTUVWXYZABCDEFGHIJ

3. Press [ENT] key fo enfer "T” Measure

which will be displayed at the [ENT] Info#1 ?

bottom of the line. -
JKLMNOPQRSTUVWXYZABC
Measure

4. Press [e] to input the lowercase [e] Info#1 2

lette. =>T
qrstuvwxyzabcdefghij
Measure

5. Press [«] or [»] key until the Info#1 2

cursor flashes in the letter "p” and [dJor[»>] _o7

press[ENT]. [ENT]

ghijkimnoparstuvwxy

Measure

Info#1 ?
=>Tp
fghijkimnoparstuvwxy

20




Measure

6. Press [e] tO enter the symbol [o] Info#17?

inputting mode. =>1Tp
@[] { | Y #5%8()*
Measure

7. Press [«] or [»] key until the [<]or[»] Info#17?

cursor flashes in the letter “#”, [ENT] =>Tp

then press [ENT]. L7 { | H #8%8& 0 +-
Measure

8. Press [ESC] key 1o enter [ESC] Info#1?

numeral inputting mode. => To#
LI {1 #8%&0* +-
Measure

9. Press numeric key [7], after [7] Info#19

confirning the inputted content, [ENT] —> To#7

press [ENT] key.

e Use [e] key 1o switch the input mode.
Capital letter Lowercase letter Symbol

ABCD €—» dbcoe———» I"#$§
eAvailable symbols to input are as follow:
17 #$%& ()*+-. / u<=>2@[ 1™\ {|}

2.9 Staff Collimation and Focus
(1) Focusing

21




Adjust the eyepiece focusing screw until the crosshair can be seen clearly. Then
adjust the focusing screw until you can see the staff clearly through the objective
lens.

A precise focusing can shorten the measuring fime and improve the accuracy.
Measurement of high accuracy requests precise focusing as well as continuous
nmeasures.

(2) Obstacles
Measurement can be implemented if the staff is blocked less than 30%. Even if the
crosshair center is blocked, as long as the field of view is blocked less than 30%,
measurement still can be implemented. However, in this case, the accuracy might
be affected.
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(3) Shadow and shaking
The surveying accuracy may be influenced if the staff is covered by shadow or the
stuff is shaking. In some cases, it is not possible to measure.

(4) Backlight and glistening

If the background of the staff is very bright, it will affect the contrast of the staff, the
digital level might not be able to measure. You can cover something ahead of the
objective len in order to reduce the background light invading to the len. When a
strong light comes info the eyepiece, it might not be able to measure either. You can
also cover the eyepiece in order to block the strong light from coming info the
eyepiece.

If the glistening of the staff is too strong, you need to rotate the staff to reduce the
glistening.

When the sun is in a low position (for example, in the morning or at night fall), or if the
sun light comes into the objective lens directly, it is suggested to block the sunlight
with hands.

2.10 Surveying Note
In order to make full use of the functions of instrument, please pay attention to the
following:
(M) Set up the staff in bright place. If possible, prolong the staff completely. If
the tower-type staff is used please pull the staff to the bayonet to make
the interval between bayonets pass muster;

bayonet

If illumination is employed, it is suggested to iluminate the whole staff, otherwise

the accuracy might be affected.
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(2) It will affect the accuracy when staff blocked. If the bar code on the staff is
blocked by free branches or leaves, the digital level might display error, or the
accuracy decreased.

(3) If the place where the staff located darker than that of the eyepiece, an error
might occur; you can block the light for the eyepiece with something proper.

(4) Deflection and pitching of the staff may affect the accuracy. During the
measurement, make sure the staff is pardlleled to the vertical hair of the reticle. The
staff should be unfolded completely and fixed well. Make sure the joints of the staff
are well and precise. Avoid to measure through the glass window.

(8) Affer a long storage or tfransportation, check and calibrate the digital and
optical sight errors. Then adjust the circular vial and keep the optical parts clean.

3. STANDARD MODE
Standard Mode includes Measure, S.O G.H, S.O H.D and S.O Dist.

3.1 Measure
In Measure function, user can measureing the staff reading and distance without
calculating the ground height. When the “Out Module” in “"Condition Setting” is sef as
“Flash” or "SD”, user needs to input job name and information. All Data will be saved
in the flash or SD card.

For the measuring time, please refer to the “Measure Mode” of “Measurement Set”
[Example]: *Out Module” is “Flash”, *“Measure Mode” is 3 times

Operating Procedures Operation Display
Menu 1/2
1. Press [ENT] key. [ENT] » Standard Mode
Leveling
Adjust
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2. Press [ENT] key.

3. Input the job name and
press [ENT].
%1), 3)

4. Input measurng point
name 12 and press [ENT].
*1), 3)

5. Input the notel-3 and
press [ENT].
*1) %3

@ If user want fo skip the
note 2 and enter to step 6, it
just needs to press [ENT] key.

6. Collimate at the staff.

[ENT]

Input job name
[ENT]

Input measuring

point
[ENT]

Input Info 1
[ENT]

Input Info 2
[ENT]

Input Info 3
[ENT]

Standard Mode

» Measure
SOGH
SOHD

1/2

Measure
Job Name?

=>J01

Measure
Meas#
=>12

Measure
Info#17?

=>]

Measure
Info#27?

=>]

Measure
Info#37?

=>]

25




Measure

7. Press [MEAS] key. [MEAS] Press[MEAS] o meas
Measuring for 3 fimes and Continuous
the result will be displayed [ESC] Meas#:12

for M seconds4) *5).

Measure
@ If the Measure Mode is Rod:
Continuous, press [ESC], the Dist:
last measuring result will be N:3 >>>>>>>
displayed for M seconds.

Measure 1/2
8. Press [REC] key fo save the [REC] Rod Ave:0.8263m
result. 36). Dist Ave:18.818m

N:3 6:0.04mm

% 1) The maximum of job name is 8 characters of capital letter or number, and the
maximum of note is 16 characters of lowercase and capital letter, number and
symbols.

% 2) The maximum of point name is 8 characters.

%3) When the “record mode” is off, the job name, point name and note can not be
inputted.

eRelationship between measuring number (Mn) and point name(Pn)is as follow:

Mn 11 Pn 1 Mn 12 Pn 1 Mn 13 Pn T....
Pn 2 Pn 2 Pn 2
Pn 3 Pn 3 Pn 3

%*4) “Wait Time” can be set manually, please refer to “Set”
»5) Affer measuring, the result will be displayed. Press [ A ] or [ ¥ ] 1o switch the page.
¥ 6) Affer being saved, the point name will increase or descend automatically.
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After measuring, press [A] or [ V] key fo switch the pages

Distance display:
Measure 1/2 N-times: average surveying value
Rod Ave;0.8263m Continuous: last surveying value
Dist Ave:18.818m N: Surveying time
N:3 6:0.04mm 6: Standard offset
Measure 2/2 measured point name
Meas#:12 point name
PN:1

3.2 5.0 G.H (Stake out Ground Point)
System can measure the height of corresponding point B by the height value

(Ho+aH), which is calculated by the height (Ha) of the known point A. The

measurement result will not be saved.

Please see the example in the next page.

Operating Procedures Operation Display

27



1. Press [ENT] key. [ENT] Menu 1/2
» Standard Mode
Leveling
Adjust
2. Press [ENT] key. [ENT] Standard Mode  1/2
Measure
»S.OGH
SOHD
3. Input the ground height of Input BS G.H S.OGH
backsight point and press [ENT] Input BS G.H
[ENT]. =23.000 m
4. Input the ground height of Input SO G.H S.OGH
stakeout point and press [ENT] Input SO G.H
[ENT]. =25000 m
5. Focus and sight af the S.OG.H
backsight point, then press [MEAS] Meas BS Pt
[MEAS]. Press[MEAS] to meas
S.OGH
6. The measuring result of BRod: 1.512m
backsight point  will  be [ENT] B Dist  26.78m
displayed, then press [ENT] N:3 5:0.4mm
key.
[MEAS] S.0GH
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7. Focus and sight at the
stakeout point, then press
[MEAS].

8. The measuring value and
stakeout value will  be
displayed. t indicates that
the staff is too low and it
needs to be moved up.

Q. Press [A] or [V¥] key to
switch 1o the page of sight
distance and height of
stakeout point, then press
[ENT].

10. Press [REP] to start a new
stakeout job and start over
backsight point surveying.
Press [ENT] to continue
stakeout measurement.

Press [ESC] to exit.

[A]Or[V]
[ENT]

Meas SO Pt

Press[MEAS] o meas

SOGH

SRod: 1.612m

S.0: 1 2.100m

N:3 0:0.4mm
SOGH

S Dist:  26.78m
G.H: 22.90m
SOGH

REP: New Meas
ENT: Continue
ESC: Exit

3.3 5.0 H.D (Stake out Height Difference)

According to the inputted height difference AH which calculated from known point A

and point B, system can measure out the corresponding point B, the measurement

result will not be saved.
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Operating Procedures Operation Display
1. Press [ENT] key. [ENT] Menu 1/2
» Standard Mode
Leveling
Adjust
2. Press [ENT] key. [ENT] Standard Mode ~ 1/2
Measure
SOGH
»S.OH.D
3. Input height difference Input H.D S.OH.D
value and press [ENT]. [ENT] Input SO H.D
=-1.000 m
4. Focus and sight at the [MEAS] SOH.D
backsight point, then press Meas BS Pt
[MEAS].
Press[MEAS] to meas
5. The measuring resulf of [ENT] SOH.D
backsight  point  will  be BRod: 1.512m
displayed, then press [ENT] BDist: 26.78m
key. N:3 5:0.4mm
[MEAS] SOHD
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6. Focus and sight at the
stakeout point, then press
[MEAS].

Meas SO Pt

Press[MEAS] to meas

SOHD

[A]or[V] SRod: 1.612m
7. The measuring value and [ENT] H.D: { 0.900m
stakeout value will be N:3 5:0.4mm
displayed. | indicates that
the staff is foo high and it SOH.D
needs o be moved down. SDist.  26.78m
8. Press [A] or [V¥] key to H.D: -0.100m
switch to the page of S Dist
(Sight Distance) and H.D
(Height  Difference)  of SOH.D

stakeout point, then press
[ENT].

9. Press [REP] to start a new
stakeout job and start over
backsight point surveying.
Press [ENT] to continue
stakeout measurement.

Press [ESC] to exit.

REP: New Meas
ENT: Confinue
ESC: Exit

3.4 5.0 Dist(Stake out Distance)
According to the inputted distance Dab from known point A to point B, system can
measure the corresponding point B. The measurement result will not be saved.
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Operating Procedures

Operation

Display

1. Press [ENT] key.

2. Press [ V] key.

3. Press [ENT] key;

4. Input stakeout distance
and press [ENT];

5. Focus and sight af the
stakeout point, then press
[MEAS].

[ENT]

[V]

[ENT]

Input S.O Dist
[ENT]

[MEAS]

Menu

» Standard Mode

Leveling

Adjust

1/2

Standard Mode
Measure
SOGH
»S.OHD

1/2

Standard Mode
» 5.0 Dist

2/2

S.0 Dist
Input SO Dist
=15.000 m

S.0 Dist
Meas SO Pt

Press[MEAS] to meas
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6. Press [A] or [V] to switch
page and display the rod
reading and input value,
then press [ENT].

7. Press [ENT] to continue
stakeout measurement.
Press [ESC] to exit.

[A]or[V]
[ENT]

[ENT] or [ESC]

S.0 Dist
S Dist: 26.78m
Distt  <11.78m

S.0 Dist
S Rod: 1.005m
Input: 15.00m

S.O Dist

ENT:Continue
ESC.Exit
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4, LEVELING

In Leveling Mode, "Out Module” should be set as “Flash” or “SD”. In this section, we
take “Flash” for example.

If user wants to save leveling measured data directly to SD card, the “*Out Module”
should be set as "SD".

backsight foresight

Known Height

TP1

A

B S / B8 F.§™

4.1 Start Leveling
In “Start Leveling” function, user should input job name, pointname and height of
benchmark, and then start to do the measuring.
Leveling 1: B1—=F1—F2—B2
Leveling 2: B1—-B2—F1—F2
Leveling 3: B—F/B—I—F
Leveling 4:Outward/Return: B1—F1—F2—-B2/F1—-B1—>B2—F 2

After measuring a statfion, user can switch off the instrument to save power, the
instrument will automatically continue the next station measurement after power on.
If the measurement do not finish while power off, the point needs to be remeasured
affer switching on the instrument.
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Operating Procedures Operation Display
1. Press [ENT] key. [ENT] Menu 1/2
Standard Mode
» Leveling
Adijust
2. Press [ENT] key. [ENT] Loveing
»Start Leveling
Continue Leveling
End Leveling
3. Input job name and press | Input Job Name
[ENT]. [ENT] Leveling
Job Name?
=>J01
4. Press [A] or [ V] 1o choose [ENT] Leveling
Leveling Measurement »B1—~F1—~F2~82
mode and press [ENT]; B1—~B2~F1—~F2
B—F/B—I—F
5. Press [A] or [ V] to choose
from Input BS Pt or [A]oOr[V] Leveling 12 F
Transfer(call up an existed [ENT] Input BS Pt
basepoint height). > 1) Then Transfer
press Enter.
6. Input the point name of | Input BM# Leveling
benchmark and press [Ent] [ENT] BM#?
=>B01
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7. Input the information and
press [ENT].
(Press [ENT] directly fo skip).

8. Input ground height of
backsight point and press
[ENT].

Input Info
[ENT]

[ENT]

Info# 1

=>1]

Info: #2

=>]

Info: #37?

=>1]

Input BS G.H
=100m

1) The existed point data can be input in the menu—Data Manage—Input Pt.
% 2) User can input three groups of notes, each notes has 16 characters of numbers

or symbols

Leveling: Measurement of backsight and foresight data
Leveling measurement 1: B1—F1—F2—>B2

Please see the example next page.
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Operating Procedures Operation Display
1. After inputting the ground
height of backsight point, level BFFB
the screen will  display "Bkl Bk1
(backsight). If the previous BM#:B0]
step is  “Start  Leveling’, Press [MEAS] to meas
screen will display
BM#(Benchmark number).
2. Sight at the staff which is Level BEFB
on the backsight point (BkT). Bk
BM#:B01
3. Press [MEAS] key. Sight at Bk 1 esssasas
Example: If it measures 3 [MEAS]
fimes, after surveying, the lovel BFFB

average value wil be
displayed for M seconds

1.

4. When it is in continuous
measuring  mode,
[ESC]
measuring data  for M

press
to display the lost

seconds.

5. Then the screen wil
and the
foresight point name  wil

display  “Fr1”
increase or descend
automatically. Now press
[ESC] can modify the point

In continuous
measuring mode
[ESC]

Sight at Frl
[MEAS]

B1R0d:0.8259m
B1Dist: 3.914m

N:3 >>>>>>>>>

BFFB 1/2
B1Rod Ave:0.8259m
B1Dist Ave: 3.914m

Level

N:3 9:0.00mm
Level BFFB

Fr1

PN :PO1

Press [MEAS] to meas
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name. After that, collimate
the staff in the foresight point
(Fr1).

6. Press [MEAS].
After meaosuring, the
average value wil be

displayed for M seconds.

7. Sight at the staff in the
foresight point (Fr2) and
press [MEAS].

8. After
average

measuring, the
value wil be
displayed for M seconds.

9. Focus and sight at the
staff in the backsight point
(Bk2) and press [MEAS].

10, If
backsight and

there are more
foresight
points, user can start from
the step 2 10 9.

Sight at Fr2
[MEAS]

Sight at Bk 2
[MEAS]

Level BFFB 1/2
F1Rod Ave:0.8260m
F1 Dist Ave: 3.914m

N:3 5:0.02mm
Level BFFB

Fr2

PN :PO1

Press [MEAS] to meas

Level BFFB 1/2
F2 Rod Ave:0.8260m
F2 Dist Ave: 3.913m

N:3 6:0.02mm

Level BFFB
Bk2
BM#:BO1

Press [MEAS] fo meas

Level BFFB 1/2
B2 Rod Ave:0.8261m
B2 Dist Ave: 3.915m
N:3 6:0.02mm
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After measuring, following data will be displayed.
Press [A] or [ V] key to tum page. >
After measuring the backsight point 1(Bk 1), press [A] or [¥] to display the following

inferface:
The following items are only displayed on the
Level BFFB 1/2 N-times measuring mode:
B1 Rod Ave:0.8259m Distance to the Backsight point
B1 Dist Ave: 3.914m N times mode: Average value
N:3 ©:0.00mm Continuous mode: Last measuring value
N: Total measuring times
8: Standard offset
Level BFFB 2/2
BM#:B01 Backsight point name

After measuring the foresight point 1(Fr 1), press [A] or [¥] fo display the following

inferface:
level BFFB 1/2 Disance to the foresight point
F1 Rod Ave:0.8260m N times mode: Average value
F1 Dist Ave : 3.914m Continuous mode: Last measuring value
N:3 0:0.02mm N: Total measuring times

0: Standard offset

Level BFFB 2/2

H.D 1:-0.000Tm Height Difference from Bk1 to Frl
Fr GH1:99.9999m Ground height of forsight point
PN :PO1
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After measuring the foresight point 2(Fr 2), press [A] or [¥]to display the following

inferface:
Disance to the foresight point
level BFFB 1/2 N fimes mode: Average value
F2 Rod Ave:0.8260m Continuous mode: Last measuring value
F2 Dist Ave : 3.913m N: Total measuring times
N:3 6:0.02mm 6: Standard offset

level BFFB 2/2

d :0.000m d:backsight distance sum-foresight distance sum
3:7.828m >:backsight distance sum-+oresight distance sum
PN :PO1 Foresight point name

After measuring the backsight point 2(Bk 2), press [A] or [ ¥]to display the following

interface:
Distance to the Backsight point
level BFFB 1/3 N times mode: Average value
B2 Rod Ave:0.8260m Continuous mode: Last measuring value
B2 Dist Ave :3.915m 6: Standard offset
N:3 6:0.02mm
E.V:Elevation offset difference=(Bk1-Fr1)-(Bk2-Fr2)
level BFFB 2/3 d: backsight distance sum-foresight distance sum
E.V Limit: 0.0mm >:backsight distance sum-+foresight distance
a: 0.001Tm sum
z 7.828m
Height Difference from Bk2 to Fr2
level BFFB  3/3 Ground height of foresight point
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H.D 2:0.0000mm
Fr GH2: 100.0000m
BM#:BO1

Backsight point name

Leveling measurement 2;: B1—+B2—F1—F2

Operating Procedures Operation Display

1. Affer inputting the ground Level BBFF
height of backsight point, the BK1
screen  wil  display "Bk BVI#:B0]
(lbacksight).If the previous step is Press [MEAS] fo meas
“Start  Leveling”, screen  wil
display BM (Bench Mark).

Level BBFF
2. Sight at the staff in the | SightatBk1 Bk
backsight point (Bk1) and Press [MEAS] BM#:B01
[MEAS] key. >>>>>>>>>>>
3. Focus and sight at the sfaff in | Sightatsk2 || oo
the backsight point (Bk2) and [MEAS] B
press [MEAS]. BM#:801

Press [MEAS] fo meas
4. Sight of the stoff in the
foresight point [Fr1]. sightatFr || e B8FF
Meanwhile press [ESC] can [MEAS] Fr
change the foresight point PR:POT

name.

Press [MEAS] fo meas
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Press [MEAS] fo measure.

5. Sight at the staff in the| Sightat Fr2 Level BBEF
foresight point (Fr2) and press [MEAS] Fr2
[MEAS]. PN:POT

Press [MEAS] to meas

6. Move the station and sight at
the staff in the backsight point | Sight at Bk 1
(Bk1), and then press [MEAS]. [MEAS]

If there are more backsight and

Level BBFF
Bk1

foresight points, please repeat —_—

step 2 to 5.

Press [MEAS] to meas

After measuring, the following data will be displayed.

Press [A] or [ V] key to fum page

Affer measuring the backsight point 1(Bk 1), press [A] or [ Y] to display the following

inferface:
Level BBFF 1/2 The following items are only displayed on the
B1 Rod Ave:0.8259m N-fimes measuring mode:
B1 Dist Ave : 3.914m Distance fo the Backsight point
N:3 0:0.00mm N times mode: Average value
Continuous mode: Last measuring value
Level BFFB 2/2 N: Total measuring times
BM#:BOT o: Standard offset
Backsight point name
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After measuring the backsight point 2(Bk 2), press [A] or [ Y]to display the following

inferface:
level BBFF 1/2 Distance to the Backsight point
B2 Rod Ave:0.8260m N fimes mode: Average value
B2 Dist Ave:3.915m Continuous mode: Last measuring value
N:3 5:0.02mm 6: Standard offset
Llevel BBFF 2/2 Backsight point name
BM#:BO1

After measuring the foresight point 1(Fr 1), press [A] or [ ¥] fo display the following

interface:
Disance to the foresight point
Llevel BBFF 1/2 N times mode: Average value
F1 Rod Ave:0.8260m Continuous mode: Last measuring value
F1 Dist Ave: 3.914m N: Total measuring times
N:3 6:0.02mm 6. Standard offset

level BBFF 2/2

H.D 1:-0.0001m Height difference from Bk1 to Frl
Fr GH1:99.9999m Ground height of foresight point
PN :PO1

After measuring the foresight point 2(Fr 2), press [A] or [ V] fo display the following
inferface:
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Disance to the foresight point

Level BBFF 1/3 N times mode: Average value

F2 Rod Ave:0.8260m Continuous mode: Last measuring value

F2 Dist Ave: 3.913m N: Total measuring times

N:3 5:0.02mm &: Standard offset

Llevel BBFF 2/3 E.V:Elevation offset difference=(Bk1-Fr1)-(Bk2-Fr2)
E.V Limit:0.0mm d: backsight distance sum-foresight distance sum
d :0.000m 2 :backsight distance sum-+-oresight distance sum
3:7.828m Foresight point name

Height Difference from Bk2 to Fr2

level BBFF 3/3 Ground height of foresight point
H.D 2: 0.0000m

Fr GH2:100.000m
PN :POT

Leveling measurement 3: B—~F/B—I—F

Operating Procedures Operation Display
Level BIF
1. After inputting the ground BK1
height of backsight point, the BM#:BO1
screen will display “Bk1 Press [MEAS] to meas
(backsight).
Level BIF
Sight af Bk 1 ”
2. Sight at the staff in the [MEAS] BM#:B01
backsight point (Bk1) and Press NN
[MEAS] key.
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3. Press [IN/SQ] (ntermediate and
Stake out) .

4, Chosse
press [ENT].

“Intermediate” and

5. Input the point name of
infermediate point and press
[ENT].

6. Input the information and

press [ENT].

7. Focus and colimate the staff
in the intfermediate point.
Press [MEAS] to measure.

8. Press [REC] to save data;
[ENT]
continue

press if user wants to

intermediate  point

measurement; press [ESC] to exit.

[IN/SQ]

[A]or[V]
[ENT]

Point name
[ENT]

Info
[ENT]

[MEAS]

[REC]
[ESC]

Level BIF
BRod Ave:0.8260m
BDist Ave: 3.913m

N:3 0:0.02mm
Level BIF

Fr1

Pn  :PO1

Press [MEAS] to meas

Level BIF
» InferMediate
Stake Out

InterMediate
PN ?
=>TP0O1_

InterMediate
Info#1?

=>

InterMediate

PN :TPOT

Press [MEAS] fo meas
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9. Sight aof the stoff
foresight point (Fr1) and press
[MEAS].

in the

10. Focus and sight at the staff in
the backsight point (Bk2) and
press [MEAS].

11. Press [IN/SO] to choose
“Intermediate point and Stakeout

measurement”

12. Choose “Stake Out” and
press [ENT].

13. Whether to load the ground
height data, [ENT] for yes,[ESC] for
no.

14. Input the ground height and
press [ENT].

Sight at Frl
[MEAS]

Sight at Bk 2
[MEAS]

[IN/SO]

[A]Or[V]
[ENT]

[ESC]

[ENT]

S.O point

InferMediate

Rod Ave: 0.9030m
Dist Ave: 17.008m
N:3 6:0.02mm

IntferMediate
SaveData [REC]
Continue [ENT]

Exit [ESC]
Level BIF
Frl

PN :PO1

Press [MEAS] to meas

Level BIF
Bk2
PN :PO1

Press [MEAS] to meas

Level BIF
Fr2
PN :P0O2

Press [MEAS] to meas

Level BIF
InterMediate
» Stake Out

Stake Out

Load Data?
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15. Input the point name of
stakeout point and press [ENT].

16. Input the Info and press [ENT]

17. Sight at the stakeout point
and press [MEAS].

18. Screen will display the S.O
Rod (Stakeout rod value) and S.O
H.D (Direction and Height of the
staff movement).

19. Press [REC] to save data;
[ENT]
continue

press if user wants to

intermediate  point

measurement; press [ESC] to exit.

20. Press [ENT] to continue the
foresight point measurement.

name
[ENT]

Input note
[ENT]

[MEAS]

[REC]
[ESC]

[ENT]

Yes: [ENT] No: [ESC]

Stake Out
Input SO G.H
=3.000 m

Stake Out
Set G.H:
PN :GO1

3.000m

Stake Out
Info#1

=>

Stake Out
Set G.H:
PN GOl

3.000m

Press [MEAS] to meas

Stake Out
S.ORod: 0.9980m
S.OH.D: | 0.0275m

N:3 0:0.02mm

Stake Out
SaveData [REC]
Continue [ENT]

Exit [ESC]
Level BIF
Frl

PN :PO2
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Press [MEAS] to meas

After measuring the backsight point 1(Bk 1), press [A] or [¥] to display the following

inferface:
Level BIF 1/2 Distance 1o the Backsight point
BRod Ave:0.8260m N times mode: Average value
BDist Ave:3.915m Continuous mode: Last measuring value
N:3 6:0.02mm § . Standard measurement
Level BIF 2/2
PN: P05 Backsight point name

After measuring the foresight point 1(Fr 1), press [A] or [¥] to display the following

inferface:
Level BIF 1/3 Disance to the foresight point
F2Rod Ave:0.8260m N fimes mode: Average value
F2Dist Ave: 3.913m Continuous mode: Last measuring value
N:3 §:0.02mm | N: Total measuring fimes
8. Standard offset
Level BIF 2/3
Fr GH:100.000m Ground height of the foresight point
d :0.000m d: backsight distance sum-foresight distance sum
>:7.828m 2:backsight distance sum-+oresight distance sum
Level BIF 3/3 Height Difference from BK2 to Fr2
H.D 2: 0.0000m Foresight point name
PN :PO1
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After measuring the intfermediate point, press [A] or [¥] to display the following

interface:

InterMediiate 1/2
Rod Ave:0.8260m
Dist Ave:3.915m

N:3 6:0.02mm

InterMediate 2/2
Int GH:2.008m
PN  :TPO5

Distance to intermediate point

N times mode: Average value
Continuous mode: Last measuring value
6: Standard measurement

Ground height of intermediate point

Point name of infermediate point (the point
name will increase or descend only after
being saved.)

Affer staking out, press [A] or [ ¥] to display the following inferface:

Stake Out 1/2
S.ORod: 0.8260m
SOHD: t 3.915m

N:3 0:0.02mm
Stake Out 2/2
Dist: 12.008m

S.OG.HO: 2.005m

Measured value of the staff

N fimes mode: Average value

Continuous mode: Last measuring value
Height difference of staff upward or
downward movement.

&:Standard measurement

Sight distance of stakeout point
Ground height of stakeout point
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Leveling measurement 4: Outward/Return
Bl-F1-F2—-B2/F1-B1—-B2—F2

Operating Procedures Operation Display

1. Press [MEAS] to measure the [MEAS] Outward BFFB 1
height of the backsight bench [ENT] BK1
mark (Bk1) and press [ENT]. BM#:BO1

Press [MEAS] to meas
2. Press [MEAS] to measure the [MEAS] Ouward BFFB 1
height of foresight point (Fr1) [ENT] -
and press [ENT]. PN:PO1

Press [MEAS] to meas

Outward BFFB 1
3. Press [MEAS] to measure the [MEAS]

Fr2
height of foresight point (Fr2) [ENT]

PN:PO1
and press [ENT].

Press [MEAS] to meas
4. Press [MEAS] to measure the [MEAS] Outward  BFFB 1
height of the backsight bench [ENT] Bk2
mark (Bk2) and press [ENT]. Bi:#:B01

Press [MEAS] to meas
5. Press [ENT] to continue [ENT]
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Leveling measurement.

6. Press [MEAS] fo measure the
height of foresight point (Fr1)
and press [ENT].

7. Press [MEAS] to measure the
height of backsight point (Bk1)
and press [ENT].

8. Press [MEAS] to measure the
height of backsight point (Bk2)
and press [ENT].

9. Press [MEAS] to measure the
height of foresight point (Fr2)
and press [ENT].

10. Press [ENT] to continue
Leveling measurement.

[MEAS]
[ENT]

[MEAS]
[ENT]

[MEAS]
[ENT]

[MEAS]
[ENT]

[ENT]

Outward BFFB 1
ENT: Next Meas
REP: Repeat
MENU:End

Outward FBBF 2
Frl
PN:P0O2

Press [MEAS] to meas

Outward FBBF 2
Bk1
PN:PO1

Press [MEAS] to meas

Outward FBBF 2
Bk2
PN:PO1

Press [MEAS] to meas

Outward FBBF 2
Fr2
PN:P02

Press [MEAS] to meas

Outward BFFB 2
ENT: Next Meas
REP: Repeat
MENU:End
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11. Press [MEAS] to measure
the height of the backsight
bench mark (Bk1) and press
[ENT].

12. Press [MENU] to end the
Leveling measurement.

13. Press [ENT] to confirm

14. Press [A] [V¥] to choose
“End Outward”.

15. Input PN (point name) and
press [ENT] to confirm.

16. Input the information and
press [ENT] to confirm.

[MEAS]
[ENT]

[MENU]

[ENT]

[A][V]
[ENT]

Input PN
[ENT]

Input Info
[ENT]

Outward BFFB 3
Bk1
PN:PO2

Press [MEAS] fo meas

Outward FBBF 6
ENT: Next Meas
REP: Repeat
MENU:ENnd

Outward FBBF 6
Even station,
End meas?

Yes: [ENT]  No: [ESC]

Outward FBBF 6
CP Close
» End Outward

Outward FBBF 6
PN ?

=>

Outward FBBF 6
Info# 1

=>
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17. Press [A] [V¥] tO view the
measurement data.

18. Press [ENT] o continue the
return measurement,

19. Press [MEAS] to measure
the height of backsight point
(Bk1) and press [ENT].

20. Press [MEAS] to measure
the height of foresight point
(Fr2) and press [ENT].

21. Press [MENU] to end the

measurement,

22. Press [ENT] to confirm.

23. Press [A][ Y] fo choose.

[A][Y]

[ENT]

[MEAS]
[ENT]

[MEAS]
[ENT]

[MENU]

[ENT]

[A][V]

Point name
[ENT]

Outward  FBBF 6 1/2

Ah  CP0.558m

AhZCP 1.007m

2D CP52.00m

Outward  FBBF 6 2/2
2D BM 108.05m
G.H BM5.007m

Retun BFFB 1
Bk1
BM#:P06

Press [MEAS] fo meas

Return  FBBF 2
Fr2
PN :PO7

Press [MEAS] to meas

Return FBBF 6
ENT:  Next Meas
REP: Repeat
MENU:End
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24. Input the point name and
press [ENT] to confirm.

25, Input the note and press
[ENT] fo confirm.

26. Press [A]V] to view the
measurement data.

27. Press [ENT] fo exit Retum
Leveling measurement.

Info
[ENT]

[A][V]

[ENT]

Retun FBBF 6
Even station,
End meas

Yes: [ENT] No: [ESC]

Retun FBBF 6
CP Close
» End Retun

Retun FBBF 6
PN ?

=>

Retun FBBF 6

Info#1 =>

Return  FBBF 6 1/2

Ah  CP 0.558m

AhZCP 0.003m

2D CP 52.00m

Return  FBBF 6 2/2
D BM110.08m
G.H BM 5.003m

Menu 1/2
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Standard Mode
» Leveling
Adjust

After finishing outward and transition point measuring, following data will be
displayed.

outward FBBF 6 1/2 Ah  CP: height dif between transition

Ah CP0.558m points of the last and this

AhZCP 0.003m fime

~D CP 52.00m Ah X CP: height dif between the start
point and fransition point

return  FBBF 6 2/2 of this ime;

>D BM 110.08m > D CP: sight distance between

G.H BM 5.003m fransition points of the last
time and this fime

>D BM: sight distance between the
start point and transition
point of this time

G.H BM: height of the fransition of this
fime;

After measuring, following data will be displayed.

Press [A] or [ V] key to switch the page

Affer measuring the backsight point 1(Bk 1), press [A] or [ Y] to display the following
inferface:

The following items only display on the
Level BFFB 1/2 N-times measuring mode:
B1Rod Ave:0.8259m Distance 1o the Backsight point
B1Dist Ave: 3.914m N times mode: Average value
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N:3 5:0.00mm Continuous mode: Last measuring value

N: Total measuring times
0. Standard offset

Level BFFB 2/2
BM#:BO1 Backsight point name

After measuring the foresight point 1(Fr 1), press [A] or [¥] fo display the following

inferface:
Level BFFB 1/2 Disance to the foresight point
F1Rod Ave:0.8260m N times mode: Average value
F1Dist Ave: 3.914m Continuous mode: Last measuring value
N:3 6:0.02mm N: Total measuring times
6: Standard offset
Level BFFB 2/2 Height difference from Bk1 to Frl
H.D 1:-0.0001Tm Ground height of foresight point
FrGH1:99.9999m
PN :PO1

Affer measuring the foresight point 2(Fr 2), press [A] or [¥] to display the following
inferface:
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Disance to the foresight point
Level BFFB 1/2 N fimes mode: Average value
F2Rod Ave:0.8260m Continuous mode: Last measuring value
F2Dist Ave: 3.913m N: Total measuring times
N:3 6:0.02mm 8. Standard offset
Level BFFB 2/2 d: backsight distance sum-foresight distance sum
d :0.000m 2:backsight distance sum+oresight distance sum
>:7.828m Point name of backsight point
PN :PO1

After measuring the backsight point 2(Bk 2), press [A] or [ Y] to display the following

inferface:
Level BFFB 1/3 Distance to the Backsight point
B2Rod Ave:0.8260m N times mode: Average value
B2Dist Ave:3.915m Continuous mode: Last measuring value
N:3 6:0.02mm 8. Standard measurement
Level BFFB 2/3 E.V: Elevation offset difference =
E.V Limit:0.0mm (BKT-Fr1)-(Bk2-Fr2)
a: 0.00Tm d: backsight distance sum-foresight distance sum
2 7.828m
2:backsight distance sum-+oresight distance sum
level BFFB 3/3 Foresight point name
H.D 2:0.0000mm
Fr GH2: 100.0000m
BM#:BO1 Height difference from Bk2 to Fr2
Ground height of foresight point
Point name of backsight point
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Infroduction to point name of leveling measurement

Point Name Modification

Before measuring the foresight point, the point name can be modified, please refer
o the next chapter “Modify the Point Name”

Available Characters In Point Name
Numeral, capital lefters and "-"can be used for point name which is up to 8
characters. The used point name can be reused.

Auto Decreasing and Increasing of the Point Name
Please refer to the Chapter 9 “Set”.

Auto Increase Stepsize
If the last character of the last inputted point name is numeral, the point name will
add 1 automatically.

Auto Numeral Increasing
As if the point name is less than 8 characters, the number will move rightward and
add 1 automatically.

Example: Last ABCD-99
Now ABCD-100
As if the point name is 8 chatacters, the numiber will not move.
Example: Last ABCDE-99
Now ABCDE-00

Auto Decreasing Stepsize
If the last character of the last inputted point name is numeral, the point name will
descend 1 automatically.
When the last character is greater than 1, the numeral character will descend 1.
Example: Last ABC-02

Now ABC-01
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Next ABC-00
When the last character is O
Next character will be 9" and up to 8 characters.

Example: Lost ABC-00
Now ABC-9999
Next ABC-9998

Note: When the point name is only numeral, then it will descend 1. As if the point
nameis 1, next one will be "99999999",

eModify the Point Name
User can modify the point name before measuring the foresight point 1 (Fr1)

Operating Procedures Operation Display
Level BFFB
1. Press [ESC] before foresight Frl
measurement, the point name [ESC] PN :PO]
will move leftward. Press [MEAS] to meas
2. Press [ESC] (C) fo delete the level BFFB
character. [ESC] PN 2
3 fimes —>PO1
. Input i X
3. Input a new poing name Lovel BFFB
1, 2
PN ?
[For example:2008]; 2008 .
4. Press [ENT].
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(ENT] level BFFB

PN ?
1) The inputted alphabets or =>2008
numerals can be up to 8
characters
% 2) The used point name can lovel BFEB
be reused in the same Erl
Leveling measurement. PN 12008

Press [MEAS] to meas

Repeated Measuring key [REP]

[REP] key is used for recollecting the surveying data of backsight or foresight points
when the measurement is incorrect. The saved data before repeating measuring will
not influence on every calculating result.

[Leveling Measurement 1]

Bkl Frl Fr2 BK2

A A
[REP] { [REP]

[REP] [REP] v v
eAfter measuring the Bk1 or Fr1, user can repeat the measurement form Bk1.

v
A

v

»
>

Next Bkl

eAfter measuring the Fr2 or Bk2, user can repeat the measurement from Fr2 or Bk1.

[Leveling Measurement 2]

v

v

Bkl " BR 7 1 Fr2

A A
[REP] ¢ [REP] v

Next Bkl

[REP] & [REP] v

eAfter measuring the Bk1 or Bk2, user can repeat the measurement form Bk1.
eAftfer measuring the Fr1 or Fr2, user can repeat the measurement from Fr1 or Bk1.
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[Leveling Measurement 3]

v

Next
Bk1 Frl BK1
T[REP] REP]
[Leveling Measurement 4]
Bk1 Fri1 Fr2 » Bk2
A A
[REP][RRP] [REP]

Next Frl

eAfter measuring the Bk1 or Fr1, user can repeat the measurement form Bk1.

eAfter measuring the Fr2 or Bk2, user can repeat the measurement from Fr2 or Bk1.

Fr1

Bk1

Bk2

»
L

Fr2

A
[REP

A

[REP]

A

IREP]

[REP]

Next Bkl

eAfter measuring the Bk1 or Fr1, user can repeat the measurement form Bk1.

eAfter measuring the Fr2 or Bk2, user can repeat the measurement from Fr2 or Bk1.

Example:[ Leveling Measurement 1] After measuring Fr2, user can remeasure from

Bk1
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Operating Procedures Operation Display
Level BFFB
1. When "Bk2" shows on the [REP] Bk2
screen, press [REP]. BM#:B01
Press [MEAS] 1o meas
2. Press [ENT] fo confirm which [ENT] lovel BFFB
measurement needs to be Repedat meas FS2 2
remeasured. BN PO
Yes: [ENT]  No: [ESC]
3. Sight at backsight point and [MEAS]
Level BFFB
press [MEAS] to remeasure. After
. Repeat meas BS1 ?
that, the measured data will
, BM#:B01
display for N second.
Yes: [ENT]  No: [ESC]
4. Sight at foresight point and |  Sight at Level BFFB
press [MEAS] to remeasure. backsight BKT
press BM#:B01
[MEAS] Press [MEAS] fo meas
5. Sight at Fr2 and press [MEAS] to Sight at Level BFFB
remeasure. foresight Fri
press PN :PO1
[MEAS] Press [MEAS] fo meas
Level BFFB
6 Sight af Forsight and press Fro
[MEAS] Sight at PN :PO]
foresight Press [MEAS] fo meas
press
[MEAS]
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Intermediate Measurement [IN/SO]

[IN/SQO] key is used for collecting the separated intermediate point and sideshot point

data in Leveling measurement.

Operating Procedures Operation Display

Level BFFB
1. After measuring the [IN/SO] Frl
backsight point, press [IN/SO. PN :POT

Press [MEAS] fo meas
2. Press [ENT] to set the [ENT] Level BFFB
instrument to be ready for the Input PN > InferMediate
infermediate point [ENT] Stake Out
measurement,
3. Input the point name and Input Info nterdediate
information of the [ENT] PN
intermediate point. =>ToL
4. Colimate the staff in the
infermediate point and press Collimate InferMediate
[MEAS]. infermediate | | Nfo#1
After measurement, the rod press =
average value  wil  be [MEAS]
displayed for M seconds.
5 Press [ENT], the instrument is
ready for the next infermediate InterMediate
point  measurement;  ofter PN :TPO1
being recorded, the point [A]or[V]
name will increase Press [MEAS] to meas
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automatically; If user want to

collect more  data of InterMediate 1/2

intermediate point, please Rod Ave:2.9378m

repeat the step 4 and 5. Dist Ave:32.455m
N:3 0:0.02mm

6. Press [ESC] to exit and return Press

o the Leveling measurement. [REC],[ENT] or InferMediate 2/

[ESC] Int GH: 10.0000m

PN:TPO1
InferMediate

SaveData [REC]
Continue [ENT]
Exit [ESC]

StakeOut Key [IN/SO]

In stakeout mode, user can stakeout the point with presetting ground height.
According fo the record mode sefting, the coordinate data of stakeout point can be
saved in *Memory” or “SD card”.

:'— Move the point untill fix the

required height

Height Difference

- “‘."'--ﬁ._, N 7 e ol Grand Hc]ghl

Stakeout

Operating Procedures Operation Display
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1. After the
measurement  press  [IN/SO]

backsight

before taking the foresight
measurement,

2. Press [A]or[¥] to choose
“Stake Out”

3. Press [ENT], the coordinate
of stakeout point can be
recalled in the flash or SD card,
which can be choose in the
Condition Setting.

4, Press [A] or [¥] to choose
one job and press [ENT].

5. Press [A] or [¥] tOo choose
one point and press [ENT].

6. Confirm the chosen point
and press [ENT];

7. Input point name and press

[IN/SO]

[ENT]

[ENT]

[A]or[V]
[ENT]

[A]or[V]
[ENT]

[ENT]

Level BFFB
Frl
PN :PO1

Press [MEAS] fo meas

Level BFFB
InterMediate

» Stake Out

Stake Out

Load Data ?

Yes:ENT] No:[ESC]

Select JobP02
» JO1

J02

Jo3

Select PoiPO1
» P01
P02

Select PoiPO1

PN :PO1
G.H:10.001Tm

Yes: [ENT]  No: [ESC]
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[ENT];

8. Input the information and
press [ENT];

9. Sight at the staff in the
stakeout  point
[MEAS].  After
3-fimes measuring value and

and  press
measuring,

the average value wil be
displayed.

10. Press [ENT] to stakeout next
point, the point name will
increase automatically; press
[ESC]

mode and go back to the

to exit the Stakeout

Leveling measurement.

Input PN
[ENT]

Input Info
[ENT]

[MEAS]

[REC], [ENT] or
[ESC]

Stake Out
Set G.H: 10.001 1m
PN :GO1_

Stake Out
Info# 1

=>

Stake Out
Set G.H: 10.001 1m
PN :GO1

Press [MEAS] o meas

Stake Out 1/2
S.ORod: 0.0020m
SOHD: |1.002m
N:3 6:0.02mm

Stake Out
SaveData: [REC]
Contfinue:  [ENT]

Exit: [ESC]

The presetting coordinate data is not in the “memory” or *SD card”.

[Example 2] Manually input the ground height, point name and other information of

the stakeout point, the measuring time is 3.

Operating Procedures Operation Display
1. After the backsight Level
measurement press [IN/SO] [IN/SO] InferMediate
before taking the foresight [A]Or[V] » Stake Out
measurement. [ENT]
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Use [A] or [¥Y] to choose
“Stake Out”, then press [ENT].
2. Press [ESC] to cancel
recaling the data from

memory.

3. Input the ground height
and press [ENT].

4. Input the point name and
press [ENT].

5. Input the note and press
[ENT];

6. Sight at the staff in the
stakeout
[MEAS].
3-times

point and press
After
measuring  value

measuring,

and the average value wil
e displayed.

7. Press [ENT] to stakeout next

[ESC]

Input G.H
[ENT]

Input PN
[ENT]

Input note
[ENT]

Sight at stakeout
point
[MEAS]

Stake Out

Load Data

Yes:ENT] No:[ESC]

Stake Out
Input SO G.H
=10 m

Stake Out
Set G.H:10.000m
PN :GO1

Stake Out
Info# 1

=>

Stake Out
Set G.H:10.000m
PN :GO1

Press [MEAS] fo meas

Stake Out 1/2
S.0 Rod:0.0020m
S.OHD t1.002m
N:3 6:0.02mm
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point, the point name will

increase automatically; Press [REC] or Stake Out

press [ESC] to exit the [ENT]L[ESC] SaveData: [REC]
Stakeout mode and Qo Continue:  [ENT]
back to the Leveling Exit: [ESC]
measurement.

4.2 End the Leveling Measurement on the Transition Point
User can end the leveling measurement job on the transition point
The close job can be restarted. If user wants 1o continue the leveling measurement

job from a transition control point, please refer to "Continue Leveling”.

Please see the example next page.
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Operating Procedures Operation Display
1. Affer measuring, when the Level BFFB
screen display “Bk1”, press [MENU] Bk]
[MENU] before next PN :PO1
measurermnent. Press [MEAS] to meas
Leveling
2. Press [A] or [V¥] fo choose [A]or[V] Start Leveling
'End Leveling” [ENT] Continue leveling
»End Leveling
3. Select "CP Close” and press [ENT] ovel BFFS
[ENT] » CP Close
BM Close

4. Input the transition control Input CP Level BFFB
point (CP) name. name PN ?

+ =>

[ENT]
5. Input information 1 and 2. Level BFFB
e Press [ENT] to skip inputting the |  Input Info 1 Info#1
information. Up to 16 characters [ENT] =>
can be inputted.
6. Press [ENT]. Input Info 2
[ENT]
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7. Press [A] or [¥] to view the
data

8. Press [ENT] to exit.

[A]or[V]

[ENT]

Level BFFB
Info#2

=>

Level BFFB 1/2
Ah  CP: 0.000m
Ah ZCP: 0.002m

D CP: 38.950m

Level BFFB 2/2
2D 2CP: 233.676m
G.H.CP :10.0002m

Menu 1/2
Standard Mode

» Leveling
Adjust

4.3 End the Leveling Measurement on the Bench Mark Point

Operating Procedures Operation Display
1. After measuring, when the Level BFFB
screen display “Bk1”, press [MENU] BKT
[MENU] before next PN POT
measurement. Press [MEAS] to meas
2. Press [A] or [V¥] to choose | [A]or[V]
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“End Leveling”.

(ENT] Leveling
Start Leveling
Continue leveling
3. Select "BM Close” and press [ENT] » End Leveling
[ENT].
Level BFFB
CP Close
4. Input the bench mark (BM) Input BM b BM Close
point name and press [ENT]. name
[ENT]
Level BFFB
5. Input information 1 and 2. PN
e Press [ENT] to skip inputting the =
information. Up to 16 characters | Input Info 1
can be inputted. [ENT]
Level BFFB
Info#1
=>
6. Press [A] or [V¥] to view the | Input Info 2 Level BFFB
data [ENT] Info#2
=>
level BFFB 1/2
7. Press [ENT] to exit. [A]oOr[V] Ah  CP; 0.000m

Ah ¥CP: 0.002m
2D CP: 38.950m
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[ENT] Level BFFB 2/2
$D SBM: 233.676m
G.HBM :10.0002m

Menu 1/2
Standard Mode
» Leveling

Adijust

Note: If user end the Leveling measurement on the bench mark point, this leveling
measurement job is over. User can not continue this job.
4.4 Continue Leveling
This function is used for continuing the leveling measurement.
eThe "Out Module” in the setting mode should be “Flash” or "SD".
eThe Leveling measurement job must be ended by the “CP Close”.
eFor saving data, the “Out Module” should be set as “Flash” or “SD".

Operating Procedures Operation Display
Menu 1/2
1. Select “Leveling” and press [MENU] Standard Mode
[ENT]. » Leveling
Adjust
Leveling
2. Press [A] or [V] to select [A]or[V] Start Leveling
"Continue Leveling” and press [ENT] » Continue Leveling
[ENT] End Leveling
3. Press [A] or [¥] to select a [ENT]

job and press [ENT].

72



4. Colimate the backsight
point (Bk) and press [MEAS] to
remeasure. After measuring,
the result will be displayed for
M seconds.

Collimate BK
[MEAS]

Select Job
» JO1

Jo2

Jo3

Level BFFB
Bk1
PN :P0O5

Press [MEAS] to meas
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5. OTHER FUNCTIONS

5.1 Manually Inputting Data Key—[MANU]
According to some causes, it can not use [MEAS] key to take measurement. User can
use [MANU] to manually input the rod reading and distance from instument to the
staff.

[Example]: In the process of Leveling measurement

Operating Procedures Operation Display
1. When measuing the level BFFB
backsight, foresight or [MANU] BK1
infermediate points, user can PN :PO3
use [MANU] key instead of Press [MEAS] to meas
[MEAS].
Input rod value level  BFFB
2. Input the rod value and + Rod 2
press [ENT]. [ENT] —1.0410m
Note: The range of inputted
rod value is
-4.9999 ~ +4.9999 m
Input distance
) Level BFFB
3. Input the distance and press +
Dist ?
[ENT]. [ENT] '
i =10.000m
Note: The range of distance
value is
O ~ 99.9999m. Level BFFB 1/2

B1 Rod 1.0410m
B1 Dist 10.000m
N:Manu

Level BFFB 2/2
PN :PO3
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4. According to the previous
point is foresight or backsight
point, system will go to next
step.

Level BFFB
Fri
PN :PO4

Press [MEAS] to meas

[Example]: In the process of Standard Measurement
Operating Procedures Operation Display
Measure
1. While displaying the point [MANU]

name, use [MANU] instead of
[MEAS].

2. Input the rod value and
press [ENT].

3. Input the distance and press
[ENT].

4. Press [ENT] fo save data.
Press [ESC] fo cancel saving.

Input rod value
+
[ENT]

Input distance
+
[ENT]

[ENT] or [ESC]

[ENT]

Press [MEAS] to meas

Meas#:1

Measure
Rod ?
=1.0410m

Measure
Dist ?
=10.000m

Measure

Record Data?

Yse: [ENT]  No: [ESC]

Measure
Rod: 1.0410m
Dist:  10.000m
N: MANU
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Measure

[MEAS] Press [MEAS] fo meas

Meas#:1

5.2 Display the Distance—I[DIST]

Before measuring, user can use [DIST] to check the distance in order fo make sure the

distance of foresight and backsight points are the same.

5.3 Inverse Staff Mode—{-]

Inverse staff mode is used for measuring the inverse staff which aims at measuring
the celling.

First of all, user should set the “Inverse Mode" in setting mode as “Use”. Please refer to
chapter 8 “Set Mode” for more details.
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Operating Procedures Operation Display

Measure
1. Press [-] to set the INVERSE [] Press [MEAS] to meas
MODE as ON, then the screen
will display the symbol ', PN 1
2. Collimate the inverse staff
Measure I
and press [MEAS]. Collimate staoff Press [MEAS] fo meas
+
[MEAS] PN 1
Measure 172 1
Rod Ave:-1.9766m
Dist Ave:19.008m
N:3 0:0.02mm
3. Press [-] again to return to []
Measure 1/2

the normal measuring mode.
Rod Ave:-1.9766m

Dist Ave:19.008m
N:3 0:0.02mm

5.4 Record Data Search—[SRCH]
[SRCH] key can be used for searching and displaying the data stored in internal
memory or SD card which can be set in the “"Out Module”.

[*Out Module” is set as “Flash”]

[Example]: Searching the bench mark (BM) point
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Operating Procedures

Operation

Display

1. Press [SRCH] af the main

menu.

2. Press [A] or [¥] fo choose
the search type and press
[ENT].

3. Input the search contents.

[SRCH]

[A]or[V]
[ENT]

Input BM point
name
+
[ENT]

[SRCH]

[SRCH]

[SRCH]

Menu 1/2
» Standard Mode
Leveling

Adjust

Search
Job
PN

» BM#

Input BM#
BM#7?
=>B01

Input BM#

BM#7?

=>B01

Press [SRCH] fo search

Level BFFB
BM#:BO1
G.H:19.008m

E.V Limit:2,.00mm

Level BBFF
BM#:B01
G.H:10.001Tm

E.V Limit:2.50mm
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e After search the bench mark point, press [ A] or [ Y] to display the last or next data.
o |f the searching goes fo the end, the screen will display “No data, EOF”.
e Press [ESC] once or twice to return.

["*Out Module” is set as "SD”]
Only the files in the same group can be searched.
[Example]: Searching the bench mark (BM) point

Operating Procedures Operation Display
Menu 1/2
1. Press [SRCH] at the main » Standard Mode
menu. [SRCH] Leveling
Adjust
Group
2. Press [A] or [V¥] to choose [A]or[V] > AAA
the group and press [ENT]. [ENT] BBB
Search
3. Press [A] or [¥] to choose [A]or[V]
Job
the search type and press [ENT]
PN
[ENT].
» BM#
4. Input the search contents. Input BM point | | eyt BM#
name BM#?
=>B01
[SRCH]
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[SRCH]

[SRCH]

Input BM#

BM#7?

=>B01

Press [SRCH] fo search

Level BFFB
BM#:B01
G.H:19.008m

E.V Limit:2,.00mm

Level BBFF
BM#:B01
G.H:10.00Tm

E.V Limit:2.50mm
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6 HORIZOTAL ANGLE MEASUREMENTS

This instrument is equipped with a horizontal dial which can be used for horizontal
angle measurement. Every 1° with a graduation, every 10° with a mark in the dial,
and the graduation increases from 0° fo 350° in clockwise direction.

Horizontal Disk

(T)First, setup and level the instrument in start point C. Second, sight the telescope to
backsight point A, and rotate the horizontal tangent screw until crosshair is accurately
on the staff af point A. Rotate the horizontal dial atf 0°,

(2)Sight the felescope to point B, and adjust the horizontal tangent, until the crosshair
is accurately on the staff at point B. And the angle reading is angle between target A
and farget B, i.e. ZACB.
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Horizontal disk 307

Optical Distance Measure

With the stadia hair of the instrument and the graduation on the staff, you can
measure the distance easily. The stadia interval on the staff multiplies 100 is the
distance. The stadia interval is the interval between the upper hair and the lower hair

on the reticle.

(1) Set up the staff on the target point.
(2) Set up and level the instrument. Sight the telescope to the staff. Record the stadia

|

‘\I [TTT
0 350
A

|H I
40

interval between upper hair and lower wire as “1”,

(3) The distance "L" between instrument and staff is L=100x1.
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7. FORMAR FLASH OR SD CARD

This function is used for deleting the all files in the memory or SD card, which can not
be recycled affer formatting. In order to avoid the mistake in deleting the data, the
system requires fo input the password while formatting. The password is set by the
factory and user can not modify it. Please note that this is the only page where

record the code.
Password: 519

SD Card Formating
Operating Procedures Operation Display
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1. Press [MENU] and use [A]or
[¥] to choose “Format” and
press [ENT].

2. Input the password:519,
then press [ENT].

3. Press [A] or [¥] to choose
*SD” and press [ENT].

4, Confirm the information and
press [ENT].

[A]or[V]
[ENT]

Password: 519
+
[ENT]

[A]Or[V]

[ENT]

Menu 2/2
Data Manage

» Format

Format
Input password

=>

Format
Format Flash

» Format SD

Format
SD
Format OK?

Yes:[ENT]  No:[ESC]

Format
SD

Format...

Format
SD

Formated
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Format
SD
Power off

Auto Power Off,

Memory Formating

Operating Procedures Operation Display
Menu 2/2
1. Press [MENU] and use [A]or [A]or[V] Data Manage
[V] to choose “Format” and [ENT] » Format
press [ENT].
Format

2. Input the password:519,
then press [ENT].

3. Press [A] or [¥] to choose
“Flash” and press [ENT].

4, Confirm the information and
press [ENT].

Password: 519
[ENT]

[A]or[V]

[ENT]

Input password

=>

Format
» Format Flash

Format SD

Format
Flash
Format OK?

Yes:[ENT]  No:[ESC]
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Format
Flash

Format...

Format
Flash

Formated

Format
Flash
Power off

Auto Power Off,

8. DATA MANAGE

This chapter will infroduce how to use “"Data Manage” of main menu to manage the
memory (RAM) and SD card. The following functions are included:

e Make goup in the SD card
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e Search ( this function is the same as "SRCH")
e Copy Job (Two ways: one is fromm memory to SD card, the other is from SD card to
memory)
e Delete job in the memory or SD card
e Check the capacity of memory or SD card
e Export file to the computor
Files in the Memory and SD Card
Job and coordinate data can be saved in the memory or SD card in the following
way.
Flash
JOBO1.M
JOB0O2.L
JOBO21.A
JOB022.L

SDcard GO01
JOBO1.M
JOBO2.L
JOBO21.M
JOBO22.L

G02
JOBO1.M
JOBO2.L
JOBO21.M
JOBO22.L

oNo file in the intfernal memory.
eThe file can not be created in the SD card when, in a group, it exits a file with same
name.

eAccording to the file type, the file will add the extension name in the following order:
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L: Leveling measurement data file

.M: Standard measurement data file

A Adjustment data file

.H: Ground height file

T Inputted point file

According fo the file type, user can transfer the inputted points file, standard
measurement file, leveling measurement file and ground height file to the computer
with USB connector. The default communication port setting is as following:

Band Rate: 9600, Data Bits: 8 Stop Bits: 1, Parity: None.
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8.1 Create Group
User can create one or more group which is convenient for view and check.

Operating Procedures Operation Display
Menu 2/2
1. Press [A] or [¥] to choose [A]or[V] » Data Manage
"Data Manage”. Format

2. Press [ENT] to enter, then DataManage 173

press [A] or [¥] to choose [ENT] » Make Group
“Make Group” and press [ENT]. [A]or[V] Inout Pt
Search

3. Input the group name and

press [ENT].
Data Manoge
Input Group
. Group Name?
After the screen display “OK!”, Name
=>G01
it wil retun fo the “Data [ENT]

Manage” screen.

Data Manage
Making Group......
GO01

Data Manage

OK!

Data Manage 1/3
» Make Group
Input Pt

Search
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8.2 Search Job

Beside coordinate data, user can easily search the job in the file of SD card or

infernal memory according to the "Out Module” setting.

Operating Procedures Operation Display
Menu 2/2
1. Press [A] or [¥] to choose » Data Manage
"Data Manoge”. [A]or[Y] Forrmat
Data Manage 1/3
2. Press [ENT] to enfer, then [ENT] Make Group
press [A] or [¥] f0 choose [A]or[V] Input Pt
Search” and press [ENT]. » Search
Select Group 1
3. Press [A] or [ ¥] to choose a [A]or[V]
» G0l
group and press [ENT]. [ENT]
G02
G03
Search
4. Press [A] or [¥] fo choose [ENT] > Srandard Mode
the the type of job, and press Leveling
5. Press [A] or [ Y] fo choose a [ENT]

job.

90




e Press [ESC] fo return to the
Menu screen.

Select JobPO1
» JO1

Jo2

Jo3

8.3 Copy Job
The job in the SD card can be copied to the internal memoaory, vice versa.
Operating Procedures Operation Display

Menu 2/2
1. Press [MENU] and [A] or [V] [AJor[V] » Data Manage
to choose "Data Manage”. [ENT] Format
2. Press [MENU] and [A] or [ V] Data Manage 23
fo choose “Copy Job”, then [A]or[V] > Copu Job
press [ENT]. [ENT] Delete Job

Check Capacity
3. Press [A] or [¥] to choose Copyfrom
*SD" and press [ENT]. (A]or[Y] Flosh
ENT] »SD
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4. Press [A] or [¥] to select a
group and press [ENT].

5. Press [A] or [ ¥] to select the
job type and press [ENT].

6. Press [A] or [¥] fo select a
job and press [ENT].

7. Press [A] or [¥] tO choose
*SD” and press [ENT].

8. Press [A] or [¥] to select a
group and press [ENT].

[ENT]

[ENT]

[ENT]

[A]or[V]
[ENT]

[A]Or[V]
[ENT]

Select GroPO1
» GO0l

G02

G03

Job Type
» Standard Mode
Leveling

Adijust

1/2

Select JobPO1
» JO1

Jo2

JO3

Copy to
Flash
»SD

Select GroPO1
GO01

»G02
G03

Data Manage

Complete

Data Manage

» Copu Job
Delete Job
Check Capacity

2/3
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8.4 Delete Job
According to the “"Out Module” setting, user can delete the job data which is saved in
SD card or internale memory.

Operating Procedures Operation Display
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1. Press [MENU] and [A] or [ V]
to choose "Data Manage”.

2. Press [MENU] and [A] or [ V]
to choose “"Delete Job”, then

press [ENT].

3. Press [A] or [ V] fo select a
group and press [ENT].

4. Press [A] or [ V] to select the
job type and press [ENT].

5. Press [A] or [¥] fo select a
job and press [ENT].

6. Press [ENT] o confirm.

[A]or[V]
[ENT]

[A]or[V]
[ENT]

[A]Or[V]

[ENT]

[ENT]

[ENT]

[ENT]

Menu 2/2
» Data Manage

Format

Data Manage 2/3
Copu Job

» Delete Job
Check Capacity

Select GroPO1
»GO01

G02

G03

Job type 1/2
Standard Mode
» Leveling

Adjust

Select JobPO1
»JO1

J02

Jo3

Data Manage

Delect?
Standard:JO1
Yes:[ENT]  No:[ESC]
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[ENT]

Data Manage

Completed

Select GroPO1
» GO0l

G02

G03

8.5 Check the Capacity of Flash or SD Crad
User can check the capacity of flash or SD card by the following method.

Operating Procedures Operation Display
Menu 2/2
1. Press [MENU] and [A] or [¥] | [A]or[Y] » Data Manage
fo choose "Data Manage”. [ENT] Format
2. Press [MENU] and [A] or [ V] Data Monage 213
to choose “Capacity”, then [A]or[V] Copu Job
press [ENT]. [ENT] Delete Job
» Check Capacity
3. Press [A] or [¥] to choose
Check Capacity
*Flash” and press [ENT]. [A]or[V]
» Flash
[ENT]
SD
4. Press any key to go back to [ENT]

the previous screen.
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Check Capacity
Flaosh:96%

[ENT] Press Any Key exit

Check Capacity
» Flash
SD

8.6 File Out
The jobs in files or infernal memory can be transferred to external instrument.
Operating Procedures Operation Display
Menu 2/2
1. Press [MENU] andl [A] or [Y] | [A]or[V] » Data Manage
fo choose “"Data Manage”. [ENT] Format

2. Press [MENU] and [A] or [ V]
fo choose ‘File Out’, then [A]or[Y]
press [ENT]. [ENT]

Data Manage 3/3
» File Out

3. Press [A] or [¥] to choose
Flash and press [ENT]. [A]or[V]
[ENT]

Select Memory
»SD
Flash
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4. Press [A] or [ V] to select job
type and press [ENT].

5. Press [A] or [ ¥] to select the
job and press [ENT].

6. Press [ENT] o confirm.

7. After sending, the screen will
go back to "Data Manage”.

[A]or[V]
[ENT]

[A]or[V]
[ENT]

[ENT]

Job Type
» Standard Mode
Leveling

Adijust

Select JobPO1
» JO1

Jo2

Jo3

Data Manage
Send Data?
JO1

YesENT]  No:[ESC]

Data Manage

Sent

97




Q. SET
The “Set” mode is used for sefting the parameters of leveling measurement, for
example, user can set the unif, communication parameter efc. The setting will

remain after switching off.

9.1 Set Menu

Menu 1/2
» Standard Mode
Leveling
Adjust

‘

Setting
» Measurement
Condition
Instrument
v !
Measurement  1/2 Con di‘rior} 12 Instrument
» Measure Mode » Point No. » Contrast
Minimum Reading Wait Time Backlight
Inversei\/lode Out Module Instrument Info
Measurement  2/2 Con di‘rior} 2/
> Unit » Communication
Auto OFF
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1. Measurement Mode:
In *Measurement Mode” user can select one of the following measure modes. Single, N
Times and Continuous. It is recommended to increase the number of measurements

fo camy out a high-accuracied resuft.

Option Function

Set the N times measurement mode.
N Times

The range of N is T fo 99
Single Single measurement mode
Continuous Continuous measurement mode

2. Minimum Reading:
"Minimum Reading” is used for setfting the minimum reading unit

Option Function
Standard Tmm
Precise 0.1mm

3. Inverse Mode:

“Inverse Mode” is used for sefting the inverse staff measurement. Please refer 1o the

“Inverse Staff Mode”

Option Function
No Use No use the “inverse Mode”
Use Use the “Inverse mode”
4. Unit:
“Unit” is used for setting the unit.
Option Function
m Measurement unit: m(meter)
4 Measurement unit: US.fi(US.Feet)
1m=3.280833333333333ft
5. Out Module:

*Out Module” is used for setting whether to save the data and the place where it will
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be save.
Please refer fo the: Setting the Data Out Module”

Option Function
Flash To save data in infemal memory
SD To save data in SD card
USB To connect the instrument with computer
OFF Do not save the data
6. Point No.

“Point No.” is used to selecting the point name increasing or decreasing.

7. Wait Time:
"Wait Time * is used for setting the display time which is from a certain screen to the
next screen.

Option Function

M Second 1~9 seconds optional

8. Communication
“*Communication” is used for setfting the parameters of communication.

1 Menu 2 Menu Function

Stondard | -------- Standard setting:

Baudrate:9600, Date Bits:8,

Stop Bits:1, Parity: None

User Baudrate | Baudrate:300/600/1200/2400/4800/9600
Parity Parity unit: Even, Odd and None optional

9. Auto OFF:
"Auto OFF” is used for setting whether to use the "Auto Off” function.
If this function is on, the instrument, without any operation, will be off in 5 minutes.

Option Function
ON To set the “Auto OFF" as ON
OFF To set the "Auto OFF” as OFF
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10. Controst:

“Contrast” is used for sefting the contrast of the screen which has 9 degrees.

Option Function
Contrast To set one of the 9 degrees contrast.
11. Backlight:

"Backlight” is used for setting whether to open the backlight.

12. Instrument Infor:

In this function, user can check the instrument information such as: Model, serial

number and produce date.

9.2 Alter the Setting Mode

Example 1: To set the measurement time as 3.

Operating Procedures Operation Display

Menu 1/2
1.Before measuring or at the » Standard Mode
menu, press [SET] to display the [ SET] Leveling
"Setting” inferface. Adjust

Setting
2. Press [A] or [¥] to select [A]or[V] » Moasurernent
"Measurement” and  press [ENT] Condition
[ENT]. Instrument

Measurement 1/2
3. Press [A] or [V¥] to select [A]or[V]

» Measure Mode
"Measure Mode” and press [ENT]

Minimum Reading

[ENT].

Inverse Mode
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Measure Mode

4, Press [A] or [¥] fo select "N [A]or[V] Single
Times” and press [ENT]. [ENT] » N Times
Continuous

Measure Mode

5. Input 3 and press [ENT]. 3 Measuring firmes?
+ N=3_
[ENT] (1-99)

e Using the everage value of N-times measurement can improve the measuring

accuracy.
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10. BATTERY AND CHARGER

The on-board battery is NB-21.

Charging

(1) The output voltage of the charger is ACT10V~220V. The electric current is 450maA.
(2) Red light means the battery is being charged. Green light means charging is
finished.

(3) It will take & hours fo charge the battery.

(4) Unplug the power plug after charging.

Note: a. Battery-charging should be in the temperature of 10°C~40TC

b. When the charging time exceeds the suggested charging time, the battery
life might be shortened.

c. The battery may discharge in storage. Inspect the battery before use if the
instrument is stored for a long time.

d. The battery should be stored in a temperature below 30°C, and should be
recharged every three or four monthes.
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11. ADJUSTMENT

Circular Vial Adjustment
1. Mount the instrument on a tripod. Center the circular vial precisely by rotating the 3
fribrach screws.
2. Rotfate the instrument 180°. If the bubble is not in the center, the circular vial should
be calibrated as follow:
a. Firstly, identify the bubble moving direction, and adjust the corresponding screws
to move the bubble half of the offset.
b. Level the circular vial with the 3 fribrach screws again.
c. rotate the instrument around again 1o check whether the bubble is centered in
every direction. If not, please repeat the steps a & b until the bubble is centered.
Difference of Line of Sight
11.1 Method A
1. Two staffs are about 50m away, set up the tripod in the center and aftach the
instrument on it.
2. Leveling the instrument;

3. The inspectations are as follow:
{a) (b) (a) (b)

Aa | ‘ Ab Ba 1 Bb
About 25m i About 25m -

4 ! |
N About 3m 3

Picture 1 Picture 2
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Operating Procedures Operation Display
Menu 1/2
1. Select "Adjust” according to [A]or[V] Standard Mode
the screen display and press [ENT] Leveling
[ENT]. » Adjust
2. Press [A] or [¥] fo choose Adijust
*Method A" and press [ENT]. [A]Or[V] » Method A
[ENT] Method B
3. Input the job nome and Adjust
press [ENT]. Job name Job Name?
[ENT] =>Jo1
4, Input the information 1 and Adjust
press [ENT]. Info 1 Info #1
[ENT] o
5. Input the information 2 and
Adjust
press [ENT]. Info 2
Info #2
[ENT]
=>2
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6. Input the information 3 and
press [ENT].

7. Collimate the staff in point a
and press [MEAS] (As shown in
the figure 1), meanwhile, take
measurement and the screen
will display Aa.

8. Collimate the staff in point b
and press [MEAS] (As shown in
the figure 1), meanwhile, take
measurement and the screen
will display Ab.

9. Move the instrument to point
B and level it (As shown in the
figure 2).

At this fime, user can switch off
the instrument to save power.

10. Collimate the staff in point
a and press [MEAS] (As shown
in the figure 2), meanwhile,
take measurement and the

Info 3
[ENT]

[MEAS]

[MEAS]

Adjust

Info #3

=>3

Adjust A
Point:A  Rod:a
a<---A---—b

Press [MEAS] to meas

Adjust A
PointA  Rod:a
Aa Rod:1.0567m

N:3 6:0.02mm
Adjust A
PointA  Rod:b
a----—>A----—b

Press [MEAS] fo meas

Adjust A
PointA  Rod:b

Ab Rod:1.0567m

N:3 6:0.02mm
Adjust

Method A

Move A-------—B
Relocate
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screen will display Ba.

11. Collimate the staff in point
b and press [MEAS] (As shown
in the figure 2), meanwhile,
fake measurement and the
screen will display Bb.

12.Display the adjusting value.
If user wants to continue
adjustment, press [ENT].

13. Press [ENT] to display the
rod reading of point b.

14. Rotate the rod reading of
point b and remove the
eyepiece cover 1, use
adjusting pin fo rofate the
crosshair  adjusting screw 2
under the eyepiece.

Note: This adjustment must be
carried out by the professionadl
person.

15. Colimate the staoff and
read the value manually.
Move the crosshair up and
down until the horizontal line is

[MEAS]

[MEAS]

[ENT]

Adjust A
Point:B  Rod:a
a <—_B _________ —»b

Press [MEAS] o meas

Adjust A
Point:B  Rod:a
Ba Rod:1.0567m

N:3 0:0.02mm
Adjust A
Point:B  Rod:b

Q<—-B----——--—pD

Press [MEAS] o meas

Adjust A
Point:B  Rod:b

Bb Rod:1.0567m

N:3 8:0.02mm

Adjust A
Adjusting value
+0.0000m(+0.1")
Save[ENT] NO[ESC]

Adjust
Method A
Adjust Crosshair?

Yes:[ENT]  No:[ESC]
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consistent with the correct Adijust

reading. Method A
Adjust Crosshair?

16. Press [ENT] fo return to the [ENT] Bb Rod:1.0567m

‘Adjust” interface.

Menu 1/2
Standard Mode
Leveling

» Adjust

o]0 cancelthe inspectation, user just needs to press [ESC] among step 110 11.
e\When the instrument displays the error information; press [ESC] to continue the
inspectation.

11.2 Method B
1. As shown in figure 1, attach the instrument on the fripod and set the tripod on the
point A and B which tfrisect the distance between the two staffs.
2. Leveling the instrument.

(a) (bl (a) (b)
-
-
Aa 1 i M Ba \ Bb
™ N I
I\ - - i
[ IR
/ \ - - 1A
[ L an
/ \ -' \
! | ! L
1/3 . 1/3 A 1/3 173 B 1/3 1/3
About 50m
Picture 1 Picture 2

3. The inspectation process is the same with Method A

12. TRANSPORTATION, STORING AND CLEANING
Jransporiarion
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(1) In outdoor operation, the instrument should e stored in the carrying case, or fixed
on the tripod and carried on the shoulder. Make sure not to carry the instrument
upside down.

(2) In road transportation, do not leave too much space between instrument cases.
Normally, the instrument should be stored in a special case in road transportation.

(3) In plane, train or ship transportation, the instrument should be stored in original
carrying case and carton.

(4) Delivering the battery: related law and rules should be fotally understood. Inform
the carrier before the shipment.

Storoge

(1) Notice the temperature when storing the instrument, especially the temperature
inside the car in hot summer.

(2) The battery should be removed if the instrument will be stored for a long fime.
(3) Do not store the wet instrument into the case before it is wiped dry.

Clean

(1) Clean the instrument after use.

a. If the instrument is wet by seawater, it should be wiped with a wet cloth and then
e dried by a dry cloth.

b. Wipe the dust on the instrument with a clean brush and a soft cloth. Do not blow it
with compressed air.

c. Wipe the dust on the objective lens with a clean brush, and wipe it with cotton with
mixture of alcohol and ether.

(2) When cleaning the plastic parts of the instrument, do not use volatile liquid such as
thinner and benzene. Neutral cleansing is suggested.

(3) Check each parts of the tripod after long-term use; make sure the screw and
brake parts are fighten.

(4) Clean the staff affer use; otherwise it will influence on the accuracy. Do not use
volatile liquid such as thinner and benzene to clean the staff.

(5) Store the staff in safe place. And cover the joints of the staff with cloth.
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13. SPECIFICATION

Model Specification DL-201 DL-2007
height ACCUIACY | Gigital reading 1.0mm 0.7mm
(standard deviation for
Tkm double un optic reading 2.0mm
leveling)
distance accuracy digital reading D=<10m:10mm;D>10m:D*0.001
distance range digital reading 1.5m~105m
HD 1Tmm/0.Tmm
minimum display
distance 0.1/1cm
measuring time within 3s in normal condition
magnification 32x
resolving power 3"
telescope field of view 1°20'
multi-constant 100
add-constant 0
type magnetic-damped
compensator range >+12’
accuracy 0.30" /1’
storage 16MB
point name increasing/decreasing/user-defined
data storage
connection USB
External Storage SD Card
circular vial accuracy 8/2mm
auto power off Bminutes/OFF
horizontal dial graduation 10
display LCD display of160*64dpi with illuminator

Working temperature

-20C~80C

dimension

230mm(L) x T580mm(W) x 210mm(H)

weight

2.5kg
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